<3

NVIDIA

NVIDIA Control Panel for
Quadro Professional Drivers




1 o Y 11 Tt o o 1

About the NVIDIA Control Panel .......ccoiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeees 2
L0 10T PP 2
Feature Differences from the Classic Control Panel ....................... 2
Changesin Release 256 ...covviiiiiiiiiiiiiiiiiiiiii e ees 3

Display CateQOry .uuuuueeuueuueeueeeeeennnennnenesseenenssnnsesssnssssnnsnnnnes 3

3D Settings CategOry .uuu it e ettt ettt eeeeeeeeaaaaaas 3
Workstation Category ..oovviiiiiiiiiiiiiiiiiiiii it 4
Supported Operating SystemsS.....cviiiiiiiiiiiiiiiiii it eeeeees 4
Supported NVIDIA Products....cceveiiiiiiiiiiiiiiiiiiiiii i eeeeees 5
SUPPOrted LangUages...ccviiiiiiiiiiiiiiiiiiiiiiiiieieteeieeeeeeeeeeeeeeaanenas 5
Other NVIDIA Software Applications .......cccovviiiiiiiiiiiiiiiiiiiiiiennnnns 5
Getting Support and Information ........ccoeiiiiiiiiiiiiiiiiiiiiiiiiiiiieeaannn. 6
101041 a1l o =11 o PP 6
Technical SUPPOIt .. coiiii it e eees 6
System INformation......coovviiiiiiiiiiiiiii e 6
2 Understanding the NVIDIA Control Panel........ccccceiiiiiiinnniiiiiiiiinnnns 7

Opening and Closing the New NVIDIA Control Panel...........cccviiiiiit 8

About the NVIDIA Control Panel Interface......cccovvvviiiiiiiiiiiiiiiinnnn.n. 9
Using the Main Task Area ....ooeeeiiiiiiiiiiiiiiiiiiiieeeeeeinieeeeennns 10
Using the Select @ Task Pane.........ccooieiiiiiiiiiiiiiiiiiiiiiiiiiiiiianannn, 11
Using the TOOL Bar ......uueeiiiiiiiiiiiiiiiiieiiiiiiieeeeeennnneeeeaeanns 12

Using the Navigation BUttons ........cccceviiiiiiiiiiiiiiiiiiiiiiennnnn. 12
Working with View Settings ... 12
Defining CuStOM VIEWS ..iviiiiiiiiiiiiieeiiiiiiieeeeeeeinneeeeeaanns 13

Using the MenU Bar.......c.eeiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeiineeeeeenns 13

File MENU oottt ettt et e e e e ennaeeeeaaaans 14

e 1 T o PN 14

VIEW MENU .ottt eeteeeeeeeeeeeeeessnassaenaees 15

Help MENU ..t ettt et e e e e e eneaeeeeaaaans 16
Group-SPeCifiC MENUS .. viiiiiiiiiiiii it eeeeeeeeeeeeeeeeeenns 16

3 Accomplishing NVIDIA Control Panel Tasks....ccceeeeeeeeeeieeeieeeeeeeeeannns 18

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | ii



Starting the NVIDIA Control Panel ......coovvvviiiiiiiiiiiiiiiiiiiiieeeeeeens 19

Accomplishing NVIDIA Control Panel Tasks .....cevveviiiiiinineneinnnnnnnnnnnns 20
NVIDIA Control Panel Feature List ......coviiiiiiiiiiiiiiiiiiiiiieennnnn. 21
Correlating to the NVIDIA Classic Control Panel ..........ccevvveveeenn... 26
NVIDIA Control Panel GroupsS.........eeeeeeeeiiiiiiiiiiiiiiiiiiiiineeeeaannnns 28

Using the Display Pages........uuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeennnns 28
Using the Video Pages.........uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeenans 29
Using the 3D Settings Pages.......vvviiiiiiiiiiiiiiiiiiiiiiiiiiieeieeannns 29
Using the Stereoscopic 3D Pages ......covvveiiiiiiiiiiiiiiiiiinieenannnnns 29
Using the Mobile Pages .......c.cceviiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeaa 29
Using the Workstation Pages.......cceevviiiiiiiiiiiiiiiiiiiiiiiiiiieennn, 30
Using the Networking Pages .......ccoevviiiiiiiiiiiiiiiiiiiiiiiiiiinnnnnn, 30
Using the Storage Pages ........uuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeannnns 31
Using the Performance Pages.......ccovvviiiiiiiiiiiiiiiiiiiiiiiiiiinnnn, 31
Using the System Update Pages .......ccceveiiiiiiiiiiiiiiiiiiiiiiiinnnnn, 31
A Using NVIDIA SLI Technology .......cccceeeeeeeeennenenneeeececccccccccnncnnnnes 32

Overview of SLI Technology for NVIDIA Quadro Cards ........cccceveennnn.... 33

SLI Modes for NVIDIA QUAdro GPUS....cvviiiiiiiiiiiiiiieiieeiiieeiieennnens 33
SLI Frame Rendering Mode .....ccoiiiiiiiiiiiiiiii e eeeeeenns 33
SLI Full Scene Antialiasing Mode .....ccovviiiiiiiiiiiiiiiiiiiieeeeeens 33
SLI MULEI-VIEW MOE ... e eee et eeeeeaeeeens 33

Hardware RequiremMents ........uuuiiiiiiiiiiiiiiiii i i e eiieeeeeeeaeans 34

Installation INStruCtioNS ..cveennnn i et eeeeaaes 35
Installing the Hardware ........ovviiiiiiiiiiiiiiiiiiiiiiiiiiiieiieeeees 35
Installing the Display Driver......c.veeiiiiiiiiiiiiiiiiiiiiiieeeneees 36

Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes................ 37
T o] (oY M Vo e = N 37
Selecting SLI Frame Rendering.......ccovviiiiiiiiiiiiiiiiiiiiiiiiiieenennnnn. 38

SLI Frame Rendering for ACE-Detectable Applications ................ 38
SLI Frame Rendering for Non-ACE Detectable Applications with no
GLlObaAl Preset .. .veiiiiiiiiiii it e et e e e e e enneeeees 39
SLI Frame Rendering for Non-ACE Detectable Applications with a Global
Preset (Windows XP ONlY) ..uuuueeiiiiiiiiiiiiiiiiiiiiieiieeeieeeeeeeeenes 39

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | iii



Using the Preset 3D App ProfileS ......ccoveeiiiiiiiiiiiiiiiiiiiiiannn, 39

Selecting SLI Full-scene Antialiasing.......ccovvviiiiiiiiiiiiiiiiniinnnnnnnn. 40
Selecting SLI Single-GPU Mode.....ccovviiiiiiiiiiiiiiiiiiiiiiieieeeeeeeaenns 40
Viewing the SLI Visual Indicators .......ceviiiiiiiiiiiiiiiiiiiiiiiiiiiieennns 41
Using SLI MUlti-View MOde ......ueeniiiiiiiiiiiiiii et eeeeeeeeeeaas 42
SLI Multi-OS - GPU Assignment in System Virtualization..................... 43
SLIMOSAIC MOE ..eeeiiiiiiiiiii ettt e ettt e reeeeeannnaeaens 43
B MUlti-GPU SyStemsS ...uuiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeceecescssssacsscssaaannns 44
Configuring Multi-GPU Displays in the NVIDIA Control Panel................. 45
WINAOWS XP . .eeeieeeieeiiiiii ettt e ee e eeeeeeeennnneeessseaennnnes 45
Windows Vista/WindOWS 7......eeeiiiiiiiiiiiiiierieeiiinneeeeeeeeeannnns 46
Understanding Multi-GPU Displays in the Windows Display Properties Settings
PG e ettt et e eeeereee e eeeeaaa, 48
Overview of Dualview Monitors in a Multiple-GPU System ............... 48
Monitor Order: Windows Vista Versus Windows XP .........cccevvviennnne 49
Monitor Ordering Under Windows XP .....cciiiiiiiiiiiiiiiiiiiinnnnnnnnns 49
Monitor Ordering Under Windows Vista and Windows 7 ............... 49
Monitor Order EXample ....oooviiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeees 49
Monitor Icons: Windows Vista/7 Versus Windows XP .........cc..eeeeeaee 50
Monitor Icons Under Windows XP ......uneeeiiiiiiiiiiiiiiiieiereeannnnns 50
Monitor Icons Under Windows Vista/Windows 7 ........cccevvvveennnnn 50
Monitor Order EXample ....cooviiiiiiiiiiiiiiiiiiiiiiiiiiiiieneeeens 50
Monitor Icons: nView Clone and Spanning Mode .......c.c.ccevvvvvvvnnnnnnnn 51
Determining GPU Order........uuuuiiiiiiiiiiiiiiiiieeieiiieieiieeeeeeeaannns 52
Default GPU Order ......cveiiiiiiiiiieiieiiiiiiiieeeeeeannnnneeeeeanns 52
Monitor Order After Changing the GPU Boot Priority in the BIOS.... 52
C Professional 3D Stereo .......ciiiiiiiiiiiiiiiiiiiiinneeeieccenennnnnnssccens 53
About Workstation 3D Stere0......cccvvviiiiiiiiiiiiiiiiiiiiiiiii e 53
Basic Workstation 3D Stereo Requirements........cccevviiiiiiinnnnennnnn. 53
Using 3D Stereo under Different System Configurations.................. 54
Supported Stereo Configurations Under Windows XP .................. 54

Supported Stereo Configurations Under Windows Vista/Windows 7. 55

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | iv



Using Workstation 3D Stere0 ......uueiiiiiiiiiiiiiiiiiiii it iiiiiieeeeeennns 55

Basic 3D Stereo SetUP ....uuuueiiiiiiii it 55
Selecting the Stereo Display Mode ....covvviiiiiiiiiiiiiiiiiiiiiiiieeeenenns 56
Using Workstation 3D Stereo with Multiple Displays ...................... 59
Enabling 3D Stereo with Multiple DisplayS.......cceevviiiiiiiiiinnnnnn.. 59

3D Stereo Under nView Modes......c.ueiiiiiiiiiiiiiiiiiiiiiiiiiinneen, 59

3D Stereo Under Dualview MOdeS ........ccovviiiiiiiiiiiiiiiiiinnnnnnnnn. 59

D NVIDIA Application Configuration Engine.......ccccoviiiinnniiiiciiiiinnnnss 60
0] e [1 et u [o] o PP 61
5= Lol 1<~ o TU 3T N 61
ADOUL NVIDIA ACE ... eeiiiiitiiiiiieeiieeieeeenneeeaenneeeeaanaeeaanns 61
Using ACE with Supported Applications ........ccceiiiiiiiiiiiiiiiiiiiiinnnnn.. 61
How to Determine ACE SUPPOIt ...uuennniiiiiiiiiiii e 61
Modifying Settings for ACE-detectable Applications .........ccccevvveentn 62
Using Applications that are not Supported by ACE ........ccccevnnnnna..... 63
Setting Up an Application Profile Using Global Presets................... 63
About the Global Presets ......uueiiiiiiiiiiiiiiiiiiiiiiiiiiiiiie e 64
Adding to the List of ACE-detectable Applications .......ccceevvvvvvinnnnnn 66
Frequently Asked QUESTIONS .....uuuuuiiiiiiii ittt eeeeeeeeeeeeenns 67

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | v



Figure 2.1 NVIDIA Control Panel (Windows XP Example) .....cccoviiiiiiiiiiiiinnnnnnn... 9

Figure 2.2 NVIDIA Control (Windows Vista Example) ....eeeviiiiiiiiiiiiiiiiiinnnnn.. 10
Figure 2.3 NVIDIA Control Panel Select a Task pane ........ccceeeeeeiieeeneinneeennnnnns 11
Figure 2.4 Navigation History MeNU .....coiiiiiiiiiiiiiiiiiiiii e ceieiiireeeeees 12
Figure 2.5 NVIDIA Control Panel View Settings .....ccccevviiiiiiiiiiiiiiiiieiinneeenenns 12
Figure A.1 SLI Visual INdiCators ........eeiiiiiiiiiiiiiiiiiiiiiiii ittt ecreeeen 41
Figure B.1 Dualview Mode with Four Displays Attached...........ccooiiiiiinnnnn.n. 48
Figure B.2 nView Clone Mode and Spanning Mode .......cccvviiiiiiiiiiiiiiiinnnnenn. 51
Figure D.1 Manage 3D Settings Page-ACE-detectable applications.................... 62

Figure D.2 Manage 3D Settings Page-Applications with Global Profiles, Windows XP63

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | vi



Table 2.1
Table 2.2
Table 2.3
Table 2.4
Table 2.5
Table 2.6
Table 2.7
Table 2.8
Table 3.1
Table 3.2
Table B.1
Table B.2
Table B.3
Table B.4
Table B.5
Table C.1
Table C.2
Table C.3
Table D.1

File Menu Commands ...ouueiiiiiiieiiiiiiiieiiieeeeieereenineeeeeannness 14
Edit Menu Commands ...c..ueiiiiiiiiiiiiiiieeiiiteeeeineeereeanneeeeeannnees 14
View Menu ComMmMaAaNndS .....coviuiiiiiiiteiiiiiiteriiiitereinnneeerennnneeenns 15
Help Menu Commands .....veeeiriiieiiiiiiieeeiiieeeeeieeeeeenineeeeaannnees 16
Profiles Menu Commands........oeueeiiniiiiiiiiiiiniiiiiierineeeneeeeneennns 16
Display Menu COmMmMaNAS .....eevriniiireiiieeeeeineeeeeanneeeeeenneeereennnees 17
3D Settings Menu ComMMANAS . ..ieiiieetiiiiiiiiiiiiiiiieeeeeeeeeeeaannnn 17
Workstation Menu Commands ......ooeveeeiiiiieieiiiiniereiineeereenneeeenns 17
NVIDIA Control Panel Features .......c.oevviiiiiiiiiiiiiiiiiiiiiiiiineiinnnes, 21
Graphics Driver Tasks in the NVIDIA Control Panel........ccccovvvvvennnn.... 26
Change Display Configuration Options .......ccevveeeiiiiieeieriiieeeeennnnnnn 45
Windows Monitor Numbering Example-Four Connected Displays .......... 49
Windows Monitor Numbering Example-Six Potential Displays.............. 50
Windows Monitor Numbering Example-Default Boot Priority............... 52
Windows Monitor Numbering Example-PCl Boot Priority.......ccceveee..... 52
Workstation Stereo Configurations: Windows XP........ccccevvvviiiiinnnnnnn. 54
Workstation Stereo Configurations: Windows Vista/Windows 7 ........... 55
List of Supported Stereo Display MOdES ......cevviviiiiiiiiiiiiinneennnnnns 56
Application-specific Global Presets (Not supported by ACE)............... 65

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | vii



INTRODUCTION

This quick start is addressed to users of the NVIDIA® Control Panel software. This guide
focuses on getting you up and running with your NVIDIA software.

For technical details on the features and benefits of the NVIDIA Control Panel software
and details about supported products, drivers, and other software, refer to the NVIDIA
web page — www.nvidia.com.

This chapter discusses the following major topics:
» “About the NVIDIA Control Panel” on page 2
P “Getting Support and Information” on page 6
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Chapter 01 : Introduction

About the NVIDIA Control Panel

Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows® XP,
Windows Vista, and Windows 7. You can use NVIDIA Control Panel to control your
NVIDIA hardware and access other NVIDIA software installed on your system.

Overview

In addition to setting up basic display configurations such as display resolution, refresh
rate, and multiple display use, you can:

» Tune your 3D settings with real-time preview to maximize performance or image
quality

» Customize how 3D applications work in your system

» Adjust your screen colors and contrast

» Set custom timings

» Control video image settings

» Change your HDTV format

» Control your notebook system power using PowerMizer

» Control special workstation features such as Frame Synchronization.

Feature Differences from the Classic Control Panel

The following are features that were available in the NVIDIA classic control panel, but
which are not available in the new NVIDIA Control Panel:

» Creating/Importing Color Profiles
» High Resolution Scalable Desktop
» Video Zoom

» Full-screen video mirroring

» Edge Blending

» nView Desktop Manager

nView Desktop Manager is available through the Windows control panel as a
separate applet (Windows XP only).

» MultiView Display Mode (for NVIDIA Quadro NVS graphics cards)

MultiView is available from the Windows Display Properties->Settings->Advanced
tab for Windows XP only.
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Chapter 01 : Introduction

Changes in Release 256

Display Category
» Adjust Desktop Color Settings page

e Added the ability to select the content type reported to the (HDMI) display.
Some HDMI displays can automatically adjust its settings to present the content
with the best image quality.

e Gamma slider: The gamma range is increased to 0.3 —2.8, but the range available to
the slider may be limited, depending on the Brightness and Contrast settings.

» Adjust Desktop Size and Position page

e Added the ability to select the desktop resizing mode reported to the display.
Some HDMI displays can use the information to properly present the content onto
the screen with minimal overscan or borders.

3D Settings Category
» Set SLI and PhyX pages

Changed and improved the controls for configuring SLI and PhysX:

 SLI choices now reflect use - Maximize 3D performance, activate all displays, or
disable SLI.

 Visual diagram shows which displays are connected and active, how GPUs are
grouped in SLI configurations, which GPU is used for PhysX, and the displays that
are PhysX accelerated.

e Added the ability to dedicate a GPU for PhyX.

e The SLI focus display is the primary display as specified in the Set Up Multiple
Displays page.

» Manage 3D Settings page
Removed the following Global and Program Settings
 Antialiasing full screen gamma
e Conformant texture clamp
e Error reporting
* (OpenGL) Extension limit
e Force Mipmaps
e HDR lighting
e Maximize texture memory
 Stereo - SLI rendering mode

e Texture color depth
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Chapter 01 : Introduction

Added new Global and Program Settings
e CUDA-GPUs lets you specify which GPUs to use for CUDA applications.

* Deep color for 3D applications lets 3D OpenGL applications be displayed in a
color depth higher than what is supported by the Windows desktop, depending on
application and display support.

Workstation Category

» The SDI Capture page is now available with Windows Vista and Windows 7 drivers.
» ECC State (appeared in later Release 197 versions)
New page for GPUs that support ECC (error correction code). The page lets you
e Change the Error Correction Code (ECC) state for GPUs.
e View GPU memory details.
» View System Topology
This page has been revised to a table format.
» EDID Management
Accessible from the View System Toplogy page, this feature lets you
e View the connector information.
e Get an EDID from a connected display and save it to disk.
e Force an EDID at a connector
e Remove a forced EDID from a connector.

» Manage Quadro Plex Settings page renamed to SLI Mosaic Mode.

Supported Operating Systems

NVIDIA Release 256 Quadro professional drivers are available for the following
Microsoft® Windows® operating systems:

e Windows XP Professional

e Windows XP Home Edition

e Windows XP Professional x64 Edition
e Windows Server 2003 x64 Edition

* Windows Server 2008 R2

e Windows Vista Home Basic

e Windows Vista Home Premium

e Windows Vista Business

e Windows Vista Enterprise Edition
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¢ Windows Vista Ultimate
e Windows 7 32-bit and 64-bit Editions

Supported NVIDIA Products

Refer to the release notes and NVIDIA driver download site for the list of products
supported by the driver version that you have installed on your computer.

Supported Languages

The NVIDIA Graphics Driver supports the following languages in the NVIDIA Control
Panel:

English (USA) German Portuguese (Euro/Iberian)
English (UK) Greek Russian

Arabic Hebrew Slovak

Chinese (Simplified) Hungarian Slovenian

Chinese (Traditional) Italian Spanish

Czech Japanese Spanish (Latin America)
Danish Korean Swedish

Dutch Norwegian Thai

Finnish Polish Turkish

French Portuguese (Brazil)

Other NVIDIA Software Applications

If installed, other NVIDIA software that you can access from the NVIDIA Control Panel
includes:

» NVIDIA System Tools-Performance group and System Update
» NVIDIA Stereoscopic 3D

» NVIDIA MediaShield™

» NVIDIA Network Access Manager

See the respective user documentation for information about these applications and
instructions on how to use them.
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Getting Support and Information

Online Help

» To open the online help, either :
e Press F1 on your keyboard, or

e Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA
Control Panel Help.

» Help on various topics can be viewed using the Contents, Index, or Search tabs.

Technical Support

To access the NVIDIA Technical Support web page go the following web address:

http://www.nvidia.com/page/support.html

System Information

You can get detailed information about your system and the NVIDIA Control Panel
configuration as well as version and copyright information.

» To view copyright and version information about the NVIDIA Control Panel:
From the Help menu, select About NVIDIA Control Panel.
» To view detailed system information:

Open the System Information dialog box by either selecting System Information from
the Help menu, or by clicking the System Information link at the lower left corner
of the NVIDIA Control Panel.

Click any of the tabs in the System Information dialog box.
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UNDERSTANDING THE NVIDIA
CONTROL PANEL

This chapter describes the NVIDIA Control Panel in the following sections:
» “Opening and Closing the New NVIDIA Control Panel” on page 8
» “About the NVIDIA Control Panel Interface” on page 9
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Opening and Closing the New NVIDIA Control Panel

» You can open the NVIDIA Control Panel in several ways:

¢ Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

For Windows XP

¢ From the Windows Start menu, select Control Panel, then in the Control Panel
window, double-click on the NVIDIA Control Panel icon.

%‘

MNYIDIA
Contral Panel

For Windows Vista/Windows 7

¢ From the Classic View of the Windows Control Panel, click the NVIDIA Control
Panel icon, or

%‘

MNYIDIA
Control Panel

e From the Control Panel Home view of the Windows Control Panel, click Additional
Options and then click NVIDIA Control Panel from the Additional Options

page.
» To close the NVIDIA Control Panel,

e From the File menu, select Exit, or

 C(lick the Close box in the upper right corner of the program window.
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About the NVIDIA Control Panel Interface

The NVIDIA Control Panel provides an easy-to-use interface for managing your system.

When you start the program for the first time, the NVIDIA Control Panel opens to the
first page listed in the navigation tree. On subsequent visits, the control panel reopens to
the last page visited. The NVIDIA Control Panel user interface consists of these main
areas, as shown in Figure 2.1 and Figure 2.2:

» Main Task Area

P Select a Task (Navigation tree)
» Menu bar

» Toolbar .

Tool Bar Menu Bar

& NvIDIA Control Panel

Eile Edit View Help

\;D ack \) Advanced Settings ~

Select a Task... ‘) 5 5 "
A Siirgg just Image Settings with Preview
Adjust image sektings with pre--‘we}-.t :
Manage 3D settings This page allows you o preview changes you make to the image and rendering settings. These will be your default settings for your
Monitor temperature levels hardware-accelerated 3D applications that ullize Direct3D or OpenGGL.
= Display
Maove CRT screen position
Change resolution Fa«lnmae: : Preview:

Adjust desktop color sebtings
Rotate display
Manage custom resolutions
Run multiple display wizard
Set up multiple: displays
= Video & Television
Adjust video color settings
Modify Full-screen video options
(= Workstation
View system topology
Synchronize displays
Adjust edge overlap

—

‘What do Ilook for?
Moving towards the (©) Let the 30 apphcation decide

Performance side will 5 :

increase frame rate, (O Use the advanced 3D image settings  Lake me there

but curved lines will O Use my preference emphasizing: Quality
appear jagged.

Moving towards the
‘Quality side willimprove
the smoothress you
can see on curved lines.

Select a Task Pane Description:

; Typical usage scenarios:
D) System Information

|
Control Panel Main Task Area

Figure 2.1 NVIDIA Control Panel (Windows XP Example)
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Chapter 02 : Understanding the NVIDIA Control Panel

Tool Bar Menu Bar

File Edit View Help

--e Back - @ | Advanced Settings +

Adjust Image Settings with Preview F

- 3D Settings
Adjust image settings with preview
Manage 30 settings _ _ .
i This page allows you to preview changes you make to the image and rendering settings. These will be your default settings for your
E-Display hardy 3D applications that wtilize Direct3D or OpenGL.
(Change resolution
Adjust desktop color settings

Rotate display Performance: Preview:
Set up multiple displays 1 p:

£1-Video & Television
Adiust video cokor settings

Quality:

/ What do I look for?
Moving towards the @ Let i ick
~ @ L pplica
Performance side wil e Do on decide

increase frame rate, () Use the advanced 3D image settings ~ Take me there

but curved nes will (©) Use my preference emphasizing: Quality
appear jagged.

Moving towards the
Quality side will improve
the smoothness you

can see on curved ines,

Performance Quality

Description:

) System Infogmation Typical usage scenarios:

Select a Task Pane Control Panel Main Task Area

Figure 2.2 NVIDIA Control (Windows Vista Example)

Using the Main Task Area

The main task area, in the right pane, displays the application task pages. This area of the
screen is where you will focus most of your attention as you use the NVIDIA Control
Panel to accomplish your goals. You can access specific pages using the navigation tree in
the Select a Task pane.
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Chapter 02 : Understanding the NVIDIA Control Panel

Using the Select a Task Pane

The navigation tree in the Se/ect « Task pane shows all the primary NVIDIA Control pages

that are installed on your system.

The pages are grouped according to the same categories that existed in the previous
version of the NVIDIA Control Panel.

Select a Task. ..

i=]- 30 Settings

ndjusk image sektings with prewvigw
Manage 30 sekkings
Manitar kemperature levels

[=|- Display

Fun display aptirization wizard
Maove CRT screen position
Zhange resalutian

adjusk deskkop color sektings
Rotate display

Manage custom resalukions
Sek up mulkiple displays

[=)- Wideo & Telewvision

adjust viden calar setkings

Click to expand
or collapse the
group list.

=) WiaFRSESEon

Wigw svstem bopalagy
Synchronize displays
adjust edge overlap

Click to open the
corresponding page
in the main task area.

Figure 2.3 NVIDIA Control Panel Select a Task pane
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Chapter 02 : Understanding the NVIDIA Control Panel

Using the Tool Bar

The Toolbar provides quick back and forth navigation between pages, and also lets you
choose a view setting.

Using the Navigation Buttons

The back and forward buttons let you navigate sequentially among pages that you have
visited.

You can also navigate directly to a previously visited page by clicking the list arrow next
to the back button. The drop-down menu lists all the previously visited pages in the
queue. Click the page that you want.

NVIDIA Control Panel
File Edit wiew Profiles Display Help

Standard Settings ~

Change resolution
Morve CRT screen position
Adjust image settings with previem

Working with View Settings

The currently selected view determines what options on each page are available..

NYIDIA Control Panel

File Edit Wiew Profiles Display Help

eBack *e -

Select a Task... * Skandard
= 3D Settings Advanced
Adijust imange setkjn
Manitor temperakiyrs N

Define Cuskom View, ..

[=)- Display r.
Figure 2.5 NVIDIA Control Panel View Settings

There are three available views:
p Standard
» Advanced
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Chapter 02 : Understanding the NVIDIA Control Panel

» Custom

Most commands are available for both Standard and Advanced views. However, some
options are available only if the Advanced view is selected before opening the page.
Also, task page options may different depending on the selected view. If the command
you're looking for is not displayed, select a different view.

To change the view:

» From the View menu, select Standard, Advanced, or Custom.

For the Custom command to be available, you must define a custom view as described
in the following section.

Defining Custom Views

You can customize NVIDIA Control Panel to display only the task pages you want to see
and use.
To specify which the pages to display:

1 Select View > Define Custom View... or for quicker access, use the toolbar if you
have it enabled.

2 On the Create Custom View page, select (check) the check boxes for the pages that
you want to view and click OK.

3 To leave the Custom View mode, select either Standard or Advanced from the View
menu or for quicker access, use the toolbar if you have it enabled.

4 To switch back to your custom view, select Custom.

Using the Menu Bar

The Menu bar contains standard Windows menus and menus specific to the NVIDIA
Control Panel, such as the View and Profiles menus.

Menus that are available on the menu bar may vary, depending on the NVIDIA Control
Panel group (such as, Display, Mobile, 3D Settings, or other group) you are using.
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File Menu

Commands related to printing, applying changes, and exiting the program are available
on the File menu.

Table 2.1  File Menu Commands

File Menu Description
Command
Page Setup ... Set up the current task page for printing. This control may not
be available.
Print... Print the current task page. This control may not be available.
Print Preview the page before sending it to the printer. This control
Preview.... may not be available.
Exit Close the NVIDIA Control Panel program.
Edit Menu

Commands related to cutting, copying, pasting, and selecting items are available on the
Edit menu.

Table 2.2 Edit Menu Commands

Edit Menu Description

Command

Cut Cut the selected text and place in the clipboard. This control
may not be available.

Copy Copy the selected text and place in the clipboard. This control
may not be available.

Paste Paste the text currently in the clipboard to the location of the
Windows cursor. This control may not be available.

Select All Select all items on the current page. This control may not be
available.
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View Menu

Commands related to viewing the various pages in the NVIDIA Control Panel
application modules are available on the View menu.

Table 2.3 View Menu Commands

View Menu
Command

Description

Standard

Select to view and access the majority of commonly used and
simpler tasks in the NVIDIA Control Panel applications. When
the Standard command appears with a check mark, this means
that the Standard view is currently active on your NVIDIA
Control Panel active.

Advanced

Select to view and access certain complex tasks in the NVIDIA
Control Panel applications. These tasks often require some
advanced experience using graphics hardware and software
(drivers). When the Advanced command appears with a check
mark, this means that the Advanced view is currently active on
your NVIDIA Control Panel.

Custom

Select to choose a custom view. This command appears on the
View menu only if you have used the Define Custom Views
command to customize showing/hiding specific screens.

Define Custom
View

To see only those application pages you want to see and use
based on the application modules (Display, 3D Settings, etc.)
that are installed on your system, select Define Custom Views
from the View menu.

Add Desktop
Context Menu

This is selected by default, and adds the NVIDIA Control Panel
menu item to the desktop context menu.

Add "Run with Select this option to add "Run with graphics processor” to the
graphics program context menu.
proc;essor" When this option is selected, you can choose which graphics
Option processor to use when starting a program as follows:
1. Right-click the program icon.
2. Click Run with graphics processor and then click the
graphics processor to use.
The selection applies only at the time the program is
launched.
NOTE: This menu option appears only with systems using
NVIDIA © Optimus™ technology.
Display GPU Select this option so that the GPU Activity icon appears in the
Activity lcon in = Windows notification area of the taskbar. You can then click
Notification the icon to see which programs and displays are using the
Area NVIDIA GPU.

NOTE: This menu option appears only with systems using
NVIDIA® Optimus™ technology.
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Table 2.3 View Menu Commands

View Menu Description

Command

Show (Windows XP only) Select to show the NVIDIA Control Panel

Notification notification tray icon in the Windows taskbar notification area.

Tray Icon Clicking the NVIDIA Control Panel notification icon offers a
quick way to configure key NVIDIA Control Panel settings.

Help Menu

Commands related to accessing help, system information, and copyright and version
information are available on the Help menu.

Table 2.4 Help Menu Commands

Help Menu Command Description

NVIDIA Control Panel Access the NVIDIA Control Panel online help.
Help

System Information View detailed information about your system and the
NVIDIA Control Panel configuration.

About NVIDIA Control View NVIDIA Control Panel version and copyright
Panel information.

Group-Specific Menus
These menus appear only when pages from a specific group are open.

Profiles Menu

Commands related to saving, loading, and deleting profiles are available on the Profiles
menu.

Table 2.5 Profiles Menu Commands

Profiles Menu Command Description

Load... Load a profile of display settings you have previously
saved. Click to open the Load Desktop Profile dialog
box and select a .nvp file.

Save... Save the current configuration to a profile file. Click
to open the Save Desktop Profile and enter a name
and path for the .nvp file.

Delete... Delete a profile. Click to open the Delete Desktop
Profile dialog box and locate a profile to delete.
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Display Menu
This menu item appears only when a Display group page is open.

Table 2.6 Display Menu Commands

Display Menu Command  Description

Identify Displays Select to identify the displays configured with your
system.

3D Settings Menu

This menu item appears only when a 3D Settings group page is open on an SLI system.

Table 2.7 3D Settings Menu Commands

3D Settings Menu Description
Command

Show SLI Visual Indicators | Select to verify that SLI rendering is enabled and

working.
Show PhysX Visual Select to verify the type of PhysX acceleration the
Indicator game is using - CPU or GPU - or if PhysX acceleration

is being used at all.

Workstation Menu
This menu item appears only when a Workstation group page is open.

Table 2.8 Workstation Menu Commands

Workstation Menu Description

Command

Refresh View Select to refresh the graphical representation of the

displays and graphics cards installed on your system.
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ACCOMPLISHING NVIDIA CONTROL
PANEL TASKS

This chapter provides instructions on how to use the NVIDIA Control Panel to
accomplish common tasks. It contains the following sections:

» Starting the NVIDIA Control Panel
» Accomplishing NVIDIA Control Panel Tasks

% Note: For Windows Vista/Windows 7 - Several features are cur-
rently under development and are not yet supported in the NVIDIA
Control Panel. Consult the release notes for the latest list of unsup-
ported features.

NVIDIA CONFIDENTIAL
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Starting the NVIDIA Control Panel

1 Launch the NVIDIA Control Panel:
Under Windows XP:

¢ Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

e From the Windows Start menu, select Control Panel, then in %
the Control Panel window, double-click the NVIDIA Control a
Panel icon. Control panel

Under Windows Vista/Windows 7:

* Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

a Click the Start icon, then from the Start menu click Control Panel.

b From the Classic View of the Windows Vista Control Panel, click the NVIDIA
Control Panel icon, or

From the Control Panel Home view of the Windows Vista Control Panel, click
Additional Options and then click NVIDIA Control Panel from the Additional

Options page.
1] NVIDIA Control Panel
File Edit View Help
e Back ¥ @ ‘ Advanced Settings ~
Select a Task... U -~
30 Sctiings .. Adjust Image Settings with Preview q
| a0 asti This page alaws you to preview changes you make to the image and rendering settings. These will be your default seftings for your, l
=) Display hardware-accelerated 3D applications that utilize Direct3D or OpenGL.
Change resolution
Adjust desktop color settings
i Rotate display Performance: Preview:
i-5et up multiple displays 1 3
(= Video & Television
Adjust video color settings
Quality:
What do 1 look for?
L‘lﬂvinu mward; ﬁa (@) Let the 3D application decide
inms;ﬁ,.t r:oe, () Use the advanced 30 image settings ~ Take me there
but curved ines wil () Use my preference emphasizing: Quality
appear jagged.
i o ] Ouaiity
| Moving towards the Fetformance Qr &
Quality side will improve
the smoothness you
can see on curved fines.
Description:
L) System Information Typical usage scenarios:

The groups that appear in the Select a Task pane depend on the NVIDIA hardware
software is installed on your system. For example, the Mobile group is not available on
desktop systems.

2 From the navigation tree in the Select a Task pane, click one of the links to open a
specific task page.
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Each group in the navigation tree lists different tasks that you can accomplish, and
each task page provides instructions on how to accomplish what you want. Move the
cursor over listed options to see a description and typical usage scenario for that
option.

Detailed instructions for each task are also available through the online help.

Accomplishing NVIDIA Control Panel Tasks

The NVIDIA Control Panel provides an intuitive layout for locating graphics driver
controls, including most of the controls that were available with the Classic NVIDIA
Control Panel.

¢ “NVIDIA Control Panel Feature List” on page 21 lists the current features available in the
NVIDIA Control Panel.

* “Correlating to the NVIDIA Classic Control Panel” on page 26 shows where a Classic Control
Panel feature is found in the new NVIDIA Control Panel.

e “NVIDIA Control Panel Groups” on page 28 provides an overview of the NVIDIA Control
Panel pages by group.
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NVIDIA Control Panel Feature List

Table 3.1

NVIDIA Control Panel Features

Feature

Values (Default in bold)’

Notes

Display/TV Controls
Mode control

Resolution

Non-HD display - the
native resolution or the
highest safe resolution
from the monitor EDID is
the default.

HD display - the highest
progressive resolution is
the default.

Refresh rate

Color depth/quality

Custom timings/resolutions

TV Signal Format Selection

M/NTSC, PAL, M/PAL, N/
PAL, Select by country

Connector Selection

Auto-select,

DVI - PC display,
VGA - PC display,
S-Video - SDTV,
Component,

Composite - SDTV,
Composite - HDTV,

HDMI - HDTV (audio
enabled (Vista and later)),
HDMI-HDTYV (audio disabled
(Vista and later)),
DisplayPort - HDTV,
DisplayPort - PC display,
LVDS - laptop display

Available values depend
on the actual
connection.

For DVI, VGA, or
Component connectors,
the values are static and
cannot be changed.

Color Control

Brightness 0 - 100%, (50%)
Contrast 0 - 100%, (50%)
Gamma 0.50 - 1.50, (1.00)

Digital Vibrance

0 - 100%, (0%)

Image sharpening

0 - 100%, (0%)

Not available with
GeForce 8 series and
later GPUs.
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Table 3.1 NVIDIA Control Panel Features
Feature Values (Default in bold)’ = Notes
Hue 0 - 359 degrees (30) For GeForce 8 series and

later GPUs

Flicker Filter

0 - 100%, (50%)

For analog TVs

Gray border option Disabled For analog TVs; presents
unused black TV borders
as gray

Digital color format selection RGB, YCbCr For HDMI and

DisplayPort connections

Content type (ITC) reported to the
display

Auto select, Desktop
programs, Full-screen
videos, Photos, Movie,
Games

Window Vista and later;

Some HDMI displays only
- available values
dependent on display
support

Rotation

0, 90, 180, 270 degrees

Desktop Size and Position

Move CRT screen position

For VGA displays

Flat panel scaling

NVIDIA scaling

NVIDIA scaling with fixed-
aspect ratio

Display’s built-in scaling
No scaling

For non-HD display
modes on DVI/HDMI/
DisplayPort connection

Adjust screen size and position

For analog TVs

Resize HDTV desktop

For HD display modes
(over DVI/HDMI/
DisplayPort/Component
connections) that
support underscan or
desktop resizing.

Pan HD desktop when not resized

Windows XP only;

For HD display modes
(over DVI/HDMI/
DisplayPort/Component
connections) that
support underscan or
desktop resizing.

Desktop resizing mode reported to the
display

Auto-select, Overscan,
Underscan, Do not report

Windows Vista and later;
HDMI displays only

Multi-display Options
Single-display mode

Dualview (extended mode)

NVIDIA Control Panel for Quadro Professional Drivers

Release 256 v01 | 22




Table 3.1

Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

NVIDIA Control Panel Features

Feature

Values (Default in bold)!

Notes

nView Clone Mode

nView Spanning Mode

Windows XP only

Video Controls

“Use video player settings” is the default. If “Use
NVIDIA settings” is selected, the following values

apply.
Color Settings
Brightness 0 - 100%, (50%)
Contrast 0 - 100%, (50%)
Hue 0 - 100%, (0%)
Saturation 0 - 100%, (50%)
0

Gamma (including separate RGB)

.3 - 3.00, (1.00)

Advanced Color Settings

Dynamic Range Full (0—255)
Limited (16—235)
Dynamic Contrast Enhancement Disabled GeForce 9 series and
later GPUS
Color Enhancement Disabled GeForce 9 series and

later GPUs

Image Settings

Edge Enhancement

0 -100%, (0%)

Noise Reduction

0 - 100%, (0%)

Inverse Telecine option

Disabled

Internet Video Enhancement option

Disabled

Select GeForce 8 series
and later GPUs

Digital Audio

Portal to the Windows Sound Settings
panel

For GPUs that support
digital audio when an
HDMI or DisplayPort
connection is made.

HDCP

Capability verification page

For GPUs that support
HDCP.

3D Application Controls
Ambient Occlusion

Off, Performance, Quality

Windows Vista and later;
GeForce 8 series and
later GPUs

Anisotropic filtering

Application-controlled,
Off, card-specific settings

NVIDIA Control Panel for Quadro Professional Drivers

Release 256 v01 | 23




Table 3.1

Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

NVIDIA Control Panel Features

Feature

Values (Default in bold)!

Notes

Antialiasing - Mode

Application-controlled,
Off, Enhance the
application setting,
Override any application
setting

Antialiasing - Setting

Application-controlled,
card-specific settings

Antialiasing line gamma

Off, On

Antialiasing - gamma correction

Off, On

Antialiasing - transparency

Off, Multisampling,
supersampling

Buffer-flipping mode

Auto-select,
Block transfer

NVIDIA Quadro cards

CUDA - GPUs

[All CUDA-capable
GPUs]

GeForce 8 series and
later GPUs

Deep color for 3D applications

Allow, disable

Enable Overlay

Off, On

NVIDIA Quadro cards
Windows XP only

Exported pixel types

8-bpp and/or RGB555
format, None

NVIDIA Quadro cards

Maximum pre-rendered frames

0,1,2,3,4,5,6,7,8

Limits frame pre-
rendering

Multi-display/mixed-GPU
acceleration

Single, Compatible, or
Multiple display
performance modes

Multi-GPU performance mode

single-GPU, alternate
frame rendering 1 & 2,
split frame rendering, or
multi-GPU antialiasing

OpenGL Rendering GPU

Auto-select,

NVIDIA Quadro FX or NVS
cards

Power management mode

Adaptive, Prefer
maximum performance

GeForce 9 series and
later GPUs; Windows
Vista and later

Preferred Refresh Rate

Application-controlled,
Highest available

Windows Vista and later

SLI performance modes

single-GPU, alternate
frame rendering 1 & 2,
split frame rendering, or
SLI antialiasing

NVIDIA Control Panel for Quadro Professional Drivers

Release 256 v01 | 24




Table 3.1

Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

NVIDIA Control Panel Features

Feature

Values (Default in bold)!

Notes

Stereo - Display mode

Select to match stereo
viewing hardware

NVIDIA Quadro cards

Stereo - Enable Off, On NVIDIA Quadro cards
Stereo - Force shuttering Off, On NVIDIA Quadro cards
Stereo - Swap eyes Off, On NVIDIA Quadro cards
Texture filtering - anisotropic mip Off, On

filter optimization

Texture filtering - anisotropic sample | Off, On

filter optimization

Texture filtering - Negative LOD bias

Allow, Clamp

Texture filtering - Quality

High quality, Quality,
Performance, High

Balance between quality
and performance

performance
Texture filtering - Trilinear Off, On
optimization
Threaded optimization Off, On For systems with
multiple CPUs
Triple buffering Off, On
Unified back/depth buffer Off, On NVIDIA Quadro cards

Windows XP only

Vertical sync

Use the 3D application
setting, Force off, Force
on

PhysX Configuration

For systems with PhysX-
capable GPUs, a
minimum of 256MB
dedicated graphics
memory, and a minimum
of 32 processor cores

SLI/Multi-GPU Configuration

For systems with SLI or
multi-GPU ready GPUs.

3-way SLI Mode

Quad SLI Mode

i. Defaults for the 3D application controls are for the Global Settings tab. Under the Program Set-
tings tab, Use global setting is typically the default setting.
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Correlating to the NVIDIA Classic Control Panel

Table 3.2 lists the features as presented in the Classic Control Panel and identifies the
page in the NVIDIA Control Panel where you can find the corresponding controls.

Table 3.2  Graphics Driver Tasks in the NVIDIA Control Panel
Feature NVIDIA Control Panel | Notes
Group - Page
Advanced Timings ‘ Display - Change
Resolution
Antialiasing 3D Settings - Manage
3D Settings
Application Profiles 3D Settings - Manage
3D Settings
Color Depth Display - Change
Resolution

Custom Timings

Desktop Color Settings

Driver Settings

Desktop Overlap

‘ Display - Change

Resolution

‘ Display - Adjust
Desktop Color Settings

3D Settings - Manage

3D Settings

Workstation - Adjust
Edge Overlap

Available only with NVIDIA Quadro
FX cards.

Frame Synchronization

HDTV Setup

Multi-display configuration ‘

nView Clone Mode

nView Span Modes

NVRotate

Performance and Quality
Settings

PowerMizer

Workstation -
Synchronize Displays
Display - Change
Resolution

Display - Set Up
Multiple Dislays

‘ Display - Set Up
Multiple Displays

Display - Set Up
Multiple Displays

' Display - Rotate

Display

3D Settings - Adjust
Image Settings with
Preview

~ Mobile - Change

PowerMizer Settings

NVIDIA Control Panel for Quadro Professional Drivers

Available with NVIDIA Quadro G-
Sync cards.

Available only with Windows XP.

Available only with notebook
computers.

Available only with Windows XP.

Release 256 v01 | 26



Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

Table 3.2  Graphics Driver Tasks in the NVIDIA Control Panel

Feature NVIDIA Control Panel Notes
Group - Page
Refresh Rate Settings Display - Change
Resolution
Resolution Settings Display - Change
Resolution
Screen Position on CRT Display - Adjust
Desktop Size and
Position
Screen Position on TV Display - Adjust
Desktop Size and
Position
SDI (Graphics to SDI Output), Workstation - Send Available only with NVIDIA Quadro
Graphics to SDI FX SDI cards.
Output
SLI Configuration 3D Settings - Set SLI
Configuration
Temperature Settings Performance Requires NVIDIA System Tools
software
TV Setup Display - Change
Resolution
Video Color Settings Video - Adjust Video
Color Settings
Overclocking Performance Requires NVIDIA System Tools
software
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NVIDIA Control Panel Groups

This section provides an overview of the NVIDIA Control Panel groups.
“Using the Display Pages” on page 28
“Using the Video Pages” on page 29
“Using the 3D Settings Pages” on page 29
“Using the Stereoscopic 3D Pages” on page 29

>

>

>

>

» “Using the Mobile Pages” on page 29

» “Using the Workstation Pages” on page 30
» “Using the Networking Pages” on page 30
» “Using the Storage Pages” on page 31

» “Using the Performance Pages” on page 31
>

“Using the System Update Pages” on page 31

Note: For Windows Versions - Support for some features under

" Windows Vista or Windows 7 is in development and may not be
available with your GeForce graphics driver version. Consult the
release notes for the latest list of unsupported features.

Using the Display Pages

The actual tasks available on your system depend on your system hardware, such as the

number and type of displays connected. Use the Display group pages to:

» Run the wizard to optimize your display configuration.

» Change the display resolution.

» Change the scaling on your flat panel display.

» Adjust desktop color settings.

» Rotate the display.

» Adjust custom timings.

» Configure multiple displays, including Spanning or Clone modes.
Spanning modes are available only with Windows XP.

» Adjust your television picture quality and video color settings for the best possible
viewing in its environment.

» Change the position and size of the desktop/video to best fit your television or HDTV
(high definition television) screen.

» Change the signal format to use for your standard television or HDTV as well as
change country-specific signal or the HDTV format.
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» Verify the HDCP capability of your system.

» Access digital audio controls.

Using the Video Pages

The actual tasks available on your system depend on your system hardware, such as
whether or not you have a TV connected and enabled. Use the Video page to:

» Adjust video and image color settings.

Using the 3D Settings Pages

The actual tasks available on your system depend on your system hardware, such as
whether or not you have an SLI-ready system. Use the 3D Settings page to:

» Change the image and rendering settings of your 3D applications and games that
utilize Direct3D and OpenGL technology.

» Assign specific 3D settings to a game so that these settings automatically load when a
game is launched (available under Advanced view).

» Set up your SLI or multi-GPU configuration as well as PhysX configuration.

GPU temperature monitoring and GPU overclocking features are not included in the 3D
Settings page. To use this functionality you must install NVIDIA nTune software.

Using the Stereoscopic 3D Pages

The Stereoscopic 3D pages are part of the NVIDIA 3D Vision software for viewing 3D
programs and games in stereoscopic 3D. Use the Stereoscopic 3D pages to:

» Control stereoscopic 3D settings.

Enable stereoscopic 3D, adjust 3D depth, select a 3D laser sight, view and set the
keyboard shortcuts, and run the setup wizard and various tests.

» View game compatibility.

See a stereoscopic 3D compatibility rating for a number of games, along with possible
issues and recommendations for each game.

Using the Mobile Pages

The Mobile group is available if the NVIDIA software is installed on a notebook
computer under Windows XP.

Use the Mobile page to extend your notebook computer’s battery life using NVIDIA
PowerMizer technology
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Using the Workstation Pages

The Workstation group is available if you have an NVIDIA Quadro FX graphics card
installed.

The actual tasks available depend on which NVIDIA Quadro FX product you have
installed. Use the Workstation page to:
» Synchronize your displays using frame sync or genlock technology.

» View a graphical representation of the displays and graphics cards installed on your
system.

» Manage serial digital interface (SDI) output (requires NVIDIA Quadro FX SDI
solution.)

» Configure SLI Mosaic mode (requires Quadro Plex unit) to combine multiple displays
into a larger virtual canvass.

» Overlap the edges of adjacent displays.
Display edge blending is no longer available.

Using the Networking Pages

The Networking group pages are part of the nForce drivers Networking software for
NVIDIA nForce-based PCs.

Use the Networking pages to optimize your network performance and increase your
network bandwidth with the following technologies:

» NVIDIA FirstPacket offers a new way to manage the traffic on your personal
computer, allowing you to more effectively manage and improve the performance of
networked games and other applications that are sensitive to network delay (latency),
such as Voice-over-IP (VoIP).

» NVIDIA TCP/IP Acceleration technology is a networking solution that moves the
processing of TCP/IP network traffic from your computer’s CPU to its nForce
hardware resulting in greatly improved system performance.

» NVIDIA Teaming technology combines all the NVIDIA Ethernet interfaces on your
system to form a team, resulting in increased bandwidth and network redundancy.

» Alert Standard Format (ASF) controls lets you set up alerts and remote system
management in an OS-present or OS-absent environment.
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Using the Storage Pages

The Storage group pages are part of the nForce drivers MediaShield Storage software for
NVIDIA nForce-based PCs.

Use the Storage pages to

» Create and manage RAID 0, RAID 1, RAID 0+1, RAID 5, and spanning arrays.

» Run SMART tests on your RAID array disk drives.

Using the Performance Pages

The Performance group pages are part of the nForce drivers System Tools software for
NVIDIA nForce-based PCs.
Use the Performance pages to:

» Manage system tuning and profiles for nForce MCP clocks, voltages, timings, and
fans.

» Manage Enthusiast System Architecture (ESA) components.
» View detailed system information for your nForce-based PC.

» Overclock your GeForce GPU.

Using the System Update Pages

The System Update pages are part of the nForce drivers System Tools software for
NVIDIA nForce-based PCs.

Use the system update pages to:

» Automatically check for nForce and GeForce driver updates.

» Update your system BIOS.

» Update firmware for the Enthusiast System Architecture (ESA) components.
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USING NVIDIA SLI

TECHNOLOGY

NVIDIA SLI technology lets you install and benefit from two PCI Express (PCle)
graphics boards in a single PC. Just as dual processors or dual core CPUs improve
computer performance, SLI allows dual GPUs (Graphics Processing Units) to
significantly accelerate graphics performance.

This chapter explains how to install, configure, and use NVIDIA SLI graphics cards as
supported in the Quadro Professional drivers.

“Overview of SLI Technology for NVIDIA Quadro Cards” on page 33

“Installation Instructions” on page 35

“Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 37
“Viewing the SLI Visual Indicators” on page 41

“Using SLI Multi-View Mode” on page 42

“SLI Multi-OS — GPU Assignment in System Virtualization” on page 43

“SLI Mosaic Mode” on page 43

vVvVvvVvVvyYVvyy
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Overview of SLI Technology for NVIDIA Quadro
Cards

Professional users benefit by using SLI technology on dual NVIDIA Quadro GPUs to
span an OpenGL window across multiple displays, or to run a single application on each
GPU. The SLI connector offers dual GPU performance on a single display by leveraging
the capabilities of two NVIDIA Quadro GPUs.

SLI Modes for NVIDIA Quadro GPUs

Following is a summary of the SLI functions available for NVIDIA Quadro GPUs:

SLI Frame Rendering Mode

SLI frame rendering combines two PCI Express graphics boards with an SLI connector to
transparently scale application performance on a single display by presenting them as a
single graphics card to the operating system. SLI frame rendering accelerates OpenGL
operation in two different ways:

» Split frame rendering: In split-frame rendering (SFR), the display is split into
distinct sections, and each section is sent to a different GPU. The resulting rendering is
recomposed and displayed as a single contiguous frame. The position of the split is
adjusted dynamically as the workload moves between the GPUs.

SER typically benefits pixel-shader or texture-intensive operations and is used in the
3D App—Visual Simulation profile.

» Alternate frame rendering: In alternate frame rendering (AFR), each GPU renders
alternate frames of data from the application.

AFR typically benefits geometry-intensive operations and is used in the 3D Apps—
Modeling AFR profile. It is also the standard SLI frame rendering method for general
use.

SLI Full Scene Antialiasing Mode

SLI antialiasing combines the power of two PCI Express graphics boards to offer higher
quality antialiasing.

SLI Multi-View Mode
SLI multi-view combines the power of two NVIDIA Quadro PCI Express graphics boards
to span a single hardware-accelerated OpenGL application window across multiple

displays, run a single application per GPU with multiple display outputs, or enable other
uses of two PCI Express graphics boards.
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Hardware Requirements

To support NVIDIA SLI technology, the motherboard and system must include the
following:

Motherboard

Your PC motherboard must be PCI Express-based, with two available and adjacent PCI
Express expansion slots. Both slots must be x16 mechanical with the following allowed
electrical slots:

» x16+x16
» x16 + x8
» x16 + x4
» x8 +x8

Graphics Cards

NVIDIA SLI requires two SLI graphics cards.
» For SLI Frame Rendering or SLI Antialiasing

» Two identical NVIDIA Quadro FX 5800, 5600, 5500, 4800, 4600, 4500 X2, 4500, 3500,
3450, or 3400 graphics cards

e An SLI bridge connector (provided with your graphics board) must also be
installed to utilize the full capabilities of SLI Frame Rendering.

» For SLI Multi-View
e Two identical NVIDIA Quadro FX 5800, 5600, 5500, 4800, 4600, 4500 X2, 4500, 3500,
3450, 3400, 1500, 1400, 560, 550 or 540 graphics cards
Power supply
» Some SLI-ready graphics boards require an external power cable.

» Since NVIDIA SLI technology supports up to two high-end graphics boards, the load
on the system’s power supply can increase significantly. A minimum of a 480W
Power Supply Unit (PSU) is recommended.

An inadequate power supply will result in erratic and unpredictable system behavior.

See the NVIDIA SLI website for updated hardware requirements information.
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Installation Instructions

Before removing current graphics boards and installing two NVIDIA Quadro FX boards,
please uninstall any current drivers and save on your Windows desktop the provided SLI
drivers.

Installing the Hardware

Note: Perform the installation in a static safe environment and utilize a properly grounded anti-
static wristband. Place any static sensitive components in anti-static bags.

1 Power off the system and remove the power cord from the power supply.
2 Gently remove or open the system enclosure.
Refer to owners manual that came with your computer.

3 Remove any non SLI-capable graphics boards that may occupy the x16 expansion slot
and replace it with your NVIDIA SLI-ready graphics board.

4 Install the second SLI-capable graphics board in the adjacent slot.
You may also need to relocate a card. The chosen slot must be x16, x8 or x4 capable.

5 Connect the two graphics boards with the SLI bridge connector.

The SLI connector is required for SLI Frame Rendering and SLI Antialiasing.

6 If your graphics boards have an auxiliary power connector, connect them to the
power supply using the supplied power connector cables.

7 Replace the system’s cover and reconnect your display(s) to the SLI-ready graphics
board installed in the x16 expansion slot.

8 Plug the power cable back into the system.
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Installing the Display Driver

Follow the steps listed below to install your driver software:

1 Power on the system and log into Windows.

2 Cancel the Windows “Found New Hardware Wizard”.
This message should appear twice — once for each graphics board.

3 Run “setup.exe” for the SLI driver you saved to your desktop.

4 Follow the “Next” prompts to proceed with driver installation.

5 Once the software has been installed, choose “Yes, I want to restart my computer
now” and select “Finish” to reboot the system.

See the following sections for instructions on using NVIDIA SLI Technology:

» “Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 37

» “Using SLI Multi-View Mode” on page 42
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Using NVIDIA SLI Frame Rendering or SLI
Antialiasing Modes

Note: Before enabling SLI technology, you must close any 3D applications that are using the
NVIDIA driver. When SLI is enabled, the video driver is reset in order to enable the second
GPU. If an application that uses the graphics driver is still open while the driver resets, this
could result in a black screen or cause the system to hang.

There are two basic steps for using SLI frame rendering and antialiasing modes:
1 Enable SLI Mode
2 Select the NVIDIA SLI mode to use:

e Selecting SLI Frame Rendering

e Selecting SLI Full-scene Antialiasing

e Selecting SLI Single-GPU Mode

These steps are described in detail in the following sections.

Enable SLI Mode

1 After logging back on to Windows, you should see the message “SLI capable system”
in the bottom right corner of the screen.

¥, SLI capable system
This system is properly configured to take advantage of SLI

multi-GPU rendering. To enable SLI multi-GPU rendering
(restart is required), click this message.

On some configurations, the message will state that SLI mode is automatically
enabled. In that case you can skip the remaining instructions in this section and
proceed to “Selecting SLI Frame Rendering” on page 38.

2 Click anywhere on the message.
If the message disappears before you can click it, continue with the following steps.
3 Right click the desktop and click NVIDIA Control Panel.
4 Under the 3D Settings category, click Set SLI configuration.
5 Under Select the SLI configuration, click Maximize 3D performance.
If you plan to use SLI Mosaic mode, click Allow SLI Mosaic Mode.

The GPU configuration visualizer shows the pending SLI configuration as well as the
display connections and enabled state of the displays. The SLI bar indicates the SLI
mode (SLI, 3-way SLI, Quad SLI, or 4-way SLI) and points to the GPUs that are used
for SLI.

6 Click Apply.

If you have more than one display connected,
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Windows XP or pre-GeForce 8 series GPUs

You can select which display to use to view your game. Use the Set up multiple
displays page to select which display to use as the primary display. The GPU
connected to this display will function as the "primary" GPU, all others will function
as slaves to the primary GPU.

If none of the displays in the SLI group are the primary display, then the driver will
select which display to use to view SLI-accelerated games.

Windows Vista/Windows 7 and GeForce 8 series and later GPUs

You can select which display to use as the SLI focus display, or the display to which
you want to apply full SLI acceleration for full-screen applications. Use the Set up
multiple displays page to select which SLI display to use as the primary display. This
becomes the SLI focus display.

If none of the displays in the SLI group are the primary display, then the driver will
select which display to use as the SLI focus display.

To use SLI frame rendering or SLI antialiasing technology, you must configure the SLI
performance mode as explained in the next section.

Selecting SLI Frame Rendering

The steps to set up SLI frame rendering depends on whether the application is ACE
detectable or whether you are using WIndows XP and a global preset exists for your
application.

Refer to “NVIDIA Application Configuration Engine” on page 60 to determine which of
the following steps to take:

» SLI Frame Rendering for ACE-Detectable Applications

» SLI Frame Rendering for Non-ACE Detectable Applications with no Global Preset

» SLI Frame Rendering for Non-ACE Detectable Applications with a Global Preset
(Windows XP Only)

SLI Frame Rendering for ACE-Detectable Applications

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click
Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select
Base profile.

3 Under the Settings Feature column, locate SLI performance mode, click its setting
to activate the list box, then click NVIDIA Recommended.

4 Click Apply.
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SLI Frame Rendering for Non-ACE Detectable Applications with no Global
Preset

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click
Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select
Base profile.

3 Under the Settings Feature column, locate SLI performance mode, click its setting to
activate the list box, then click either an AFR 1 or AFR 2 option.

There may be subtle differences in performance between AFR 1 and AFR 2, depending
on the application. You can try each one to determine which provides the best
performance with the highest quality for your application.

4 Click Apply.

SLI Frame Rendering for Non-ACE Detectable Applications with a Global
Preset (Windows XP Only)

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click
Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select
the preset or profile for your application.

See also Using the Preset 3D App Profiles below.

3 Under the Settings Feature column, locate SLI performance mode, click its setting to
activate the list box, then click NVIDIA Recommended.

4 Click Apply.

Using the Preset 3D App Profiles

The following three preset application profiles for OpenGL applications are useful in SLI
configurations:

» 3D App-Modeling AFR
This preset is useful for modeling applications, and uses SLI AFR mode.
» 3D App-Visual Simulation
This preset is useful for visual simulation applications, and uses SLI SFR mode.
» 3D App-Default Global Settings
This preset uses SLI single-GPU rendering mode, and is also useful when you need to

use non-SLI configurations.

To enable one of these profiles, click the Global Settings tab in the Manage 3D Settings
page, then click the Global presets list arrow and click the profile you want to use.
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Selecting SLI Full-scene Antialiasing

You can use SLI technology to provide higher-quality antialiasing beyond 16xFSAA. In
this mode, SLI frame rendering is not available. To use SLI antialiasing, perform the
following steps.

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click
Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select
Base profile.

3 Select an SLI antialiasing setting.

Under the Settings Feature column,

a Locate Antialiasing-Mode, click its setting to activate the list box and then click
Enhance the application setting.

b Locate Antialiasing - Setting, click its setting to activate the list box, then click
the SLI antialiasing setting you want to use.

4 Click Apply.

Selecting SLI Single-GPU Mode

SLI single-GPU mode is the default setting, and provides improved performance at a
level that assures compatibility with most applications. This is not the same as
completely disabling SLI. If you are trying to solve a compatibility issue, you may want
to completely disable SLI by clicking Disable SLI on the Manage 3D Settings->Set SLI
Configuration page.

To use single GPU mode, perform the following steps.

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click
Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select
Base profile.

3 Under the Settings Feature column, locate SLI performance mode, click its setting
to activate the list box, then click SLI single-GPU.

4 Click Apply.
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Viewing the SLI Visual Indicators

To verify that SLI mode is enabled and that the graphics cards are sharing the load,

1 From the NVIDIA Control Panel Select a Task pane, click Set SLI configuration.

2 From the menu bar, click 3D Settings, then click the drop-down menu item Show
SLI Visual Indicators.

This option enables an SLI status bar that reflects how the GPUs are working together to
render DirectX and OpenGL full-screen applications. See Figure A.1.

AFR load balancing bar
shows relative work provided
by each GPU.

NEW GAME . LOAD GAME MULTIPLAYER

SFR load balancing line
shows relative portion of th
screen rendered by each
GPU.

SLI AA indicator
shows the effect of SLI
antialiasing modes.

Figure A.1 SLI Visual Indicators
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Using SLI Multi-View Mode

Under Windows XP, only one display is used with SLI frame rendering or SLI
antialiasing mode. To use more than one display, you must use SLI multi-view mode as
follows:

1 Right click the desktop and click NVIDIA Control Panel.
2 From the 3D Settings category in the Select a task pane, click Set SLI configuration.
3 Click Disable SLI, then click Apply.

If you were using SLI multi-view mode prior to enabling SLI frame rendering mode
and you still have multiple displays connected, then the system returns to the
previous multi-view mode, whether it was Dualview, Clone, or Spanning mode.

If you have only one display connected, then the system sets to single display mode.
Continue with the following steps to use additional displays.

4 Close the NVIDIA Control Panel and then connect the additional displays that you
want to use.

5 Enable the displays per the instructions in the section “Configuring Multi-GPU
Displays in the NVIDIA Control Panel” on page 45.

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | 42



SLI Multi-OS - GPU Assignment in System
Virtualization

On systems with two supported graphics cards installed, this driver supports a system
virtualization tool’s ability to directly assign a GPU to a guest virtual machine (VM). This
direct assignment allows the host and guest VM to each run on their own operating
system and with their own GPU and driver.

» Supported Virtualization Software: Parallels Workstation Extreme
» Supported Graphics Cards
Up to two different models can be used in a system, from among the following:
e Quadro FX 5800
¢ Quadro FX 4800
¢ Quadro FX 3800
» Video BIOS Requirement
» The graphics card assigned to the guest VM needs video BIOS version
62.00.39.00.00 or later.

For a list of SLI Multi-OS certified workstations, virtualization software, and OS
combinations, please see http://www.nvidia.com/object/sli_multi_os.html .

SLI Mosaic Mode

NVIDIA® SLI® Mosaic Mode enables transparent scaling of any application up to eight
displays from two Quadro Plex systems.

SLI Mosaic Mode enables presentation of multiple GPUs (from Quadro Plex systems) as a
single logical Quadro GPU to the operating system.

See the NVIDIA SLI Mosaic Mode User’s Guide for additional information.
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MULTI-GPU SYSTEMS

This appendix discusses multi-GPU display configuration in a non-SLI (or SLI Multi-
view) configuration. It contains the following sections:

» “Configuring Multi-GPU Displays in the NVIDIA Control Panel” on page 45

» “Understanding Multi-GPU Displays in the Windows Display Properties Settings
Page” on page 48
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Configuring Multi-GPU Displays in the NVIDIA
Control Panel

Multi-GPU systems are typically systems with more than one graphics card installed, but
they can also include systems with one or more NVIDIA Quadro NVS 400 cards, or one
or more NVIDIA Quadro FX 4500 FX2 graphics cards.

In a multi-GPU system, you use the NVIDIA Control Panel to control the multi-display
mode (single, Dualview, Clone, or Spanning) in the same manner as you would in a
single-GPU system—from the Set up Multiple Displays page.

Windows XP

You can only configure displays from one “GPU” at a time. So the basic steps are as
follows:

1 Select the GPU using the Select the graphics card with the displays you want to
configure list.

1. Select the graphics card with the displays you want to configure.

B GeForce 7900 GX2 (1 of 2) w

2 Configure the displays attached to that GPU.

Table B.1 shows the options you can expect to see for each GPU, depending on how
many displays are connected to the GPU.

Table B.1 Change Display Configuration Options

Displays Connected nView Display Mode Displays to Use
Options
1 Single Display A
2 Single Display A
Display B
Multi-display modes Display A + B
Display B + A
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Table B.1 Change Display Configuration Options

Displays Connected nView Display Mode Displays to Use
Options
2+TV Single Display A
Display B
Display TV

Multi-display modes Display A + B
Display B + A
Display A + TV
Display TV+ A
Display B + TV
Display TV + B

Windows Vista/Windows 7

You can configure displays from several “GPUs” at a time.

On the Set Up Multiple Displays page, the box under Step 1 lists all the displays that
are connected to your system, and shows to which GPU they are connected.

Check or clear the check boxes to select the displays that you want to use, then click
Apply to activate the new display configuration..

1. Select the displays you want to use.

GeForce 8800 GT
[#] Dell 3007WFPHC [ 1 ]
[#] MEC LCD 1970MX (1 of 2) [ 2 |
GeForce 8800 GT

NEC LCD 1970NX (2 of 2) El

The displays will be in either extended mode or Clone mode.

Extended mode displays are identified by number in separate box icons.
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» The numbering corresponds to the numbering in the Windows Display Settings page.
» The Windows primary display is indicated by the box icon with a star.

» To switch from extended mode to Clone mode,

a Right-click one of the display icons for the display that you want to make a clone,
then click the Clone displays option from the pop-up menu.

Select the option that specifies the display that you want to be the primary clone
display.
b Click Apply.

Cloned displays are identified by numbers inside the same box icon.

» To switch from Clone mode to extended mode,

a Right-click the display icon for the display that is physically positioned on the right
side, then click Extend desktop on this display from the popup menu.

Right-clicking the box area between the circles has the same effect as clicking the
left circle.

b Click Apply.
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Understanding Multi-GPU Displays in the Windows
Display Properties Settings Page

The following explanation describes the monitor icons for multiple displays in the
Windows Display Properties Settings page.

» Overview of Dualview Monitors in a Multiple-GPU System
» Monitor Order: Windows Vista Versus Windows XP

» Monitor Icons: Windows Vista/7 Versus Windows XP

» Monitor Icons: nView Clone and Spanning Mode

» Determining GPU Order

Overview of Dualview Monitors in a Multiple-GPU System

In Dualview mode, the displays are recognized by the operating system and you can
configure each display independently. You can also attach or remove Dualview displays
using the Display Properties Settings page.

Figure B.1 illustrates the Display Properties Settings page for a system with four displays
connected in a Dualview configuration under Windows Vista.

Display Propertics

| Thenes | Desklon | Soesn Saver | Appearance| Setings

Dhiag the monbar icors o malch the physical arzngement of your morilors.

Scraen resolution Codior qualiy
Less O Mo Thighes (32 bi =
1350 by TE pinels I 730 "N '®m

[ Uze this device &5 the primary monbar,
Estend my "windaws deskbap onlo ks moniter.

[ 1dersiy || Iroubleshoct.. | [ Advanced

[ ok ][ camest ]| e

Figure B.1 Dualview Mode with Four Displays Attached
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The monitor ordering is controlled by a combination of the driver and the Windows
method of enumerating PCI devices. Because a number of factors are involved in the
enumeration of the displays, it can be difficult to predict which display icon in the
Windows Display Properties page corresponds to which display connector on the
graphic cards.

To accurately determine which icon represents which display,

1 If the display in question is already attached, skip this step. Otherwise, attach the
display by right-clicking the icon and clicking Attached, then click Apply.

2 Right click the icon again and click Identify.

The icon number appears on the display.

Monitor Order: Windows Vista Versus Windows XP

This section describes how monitors are ordered when all the displays in a multi-GPU
system are connected.

Monitor Ordering Under Windows XP

Windows XP enumerates one display from the GPU and then considers the display from
the next GPU. After it enumerates the display from the last GPU, the operating system
goes back to the first GPU to enumerate the secondary display, and so on.

Monitor Ordering Under Windows Vista and Windows 7

Windows Vista enumerates all display outputs from a GPU before considering the next
GPU.

Monitor Order Example

Table B.2 gives an example of four monitors connected to two GPUs, and shows the
general pattern the operating system uses to enumerate the monitors under Windows
Vista and Windows XP:

Table B.2 Windows Monitor Numbering Example-Four Connected Dis-

plays
Connector Monitor Number Under Monitor Number
Position Windows Vista/ Under Windows XP
Windows 7

GPUO—Output 1
GPUO—Output 2
GPU1—Output 1
GPU1—Output 2

A WIN -
A N W =

NVIDIA Control Panel for Quadro Professional Drivers Release 256 v01 | 49



Monitor Icons: Windows Vista/7 Versus Windows XP

This section describes how monitors are ordered when not all the displays in a multi-
GPU system are connected or enabled under Dualview.

Monitor Icons Under Windows XP

» Each GPU is represented by a monitor icon, regardless of whether a monitor is
connected to it.

» If a secondary display on a GPU is connected but not enabled under Dualview, there
is a monitor icon for that display but it is grayed out.

» If a secondary display on a GPU is not connected, there is no monitor icon for that
display.

Monitor Icons Under Windows Vista/Windows 7

» The Display Properties page shows all the monitors that can be supported by the
graphics cards in the system, even if they are not physically connected.

» If a display is not connected, or connected but not enabled under Dualview, the
corresponding monitor icon is grayed out.

Monitor Order Example
Table B.3 shows the general monitor numbering under Windows Vista and Windows XP
when only some of the displays are connected. Monitor numbers are always sequential,

even when displays are not connected.

Table B.3 Windows Monitor Numbering Example-Six Potential Displays

Connector Connection Monitor Number = Monitor Number
Position Status Under Windows = Under Windows
Vista/Windows 7 XP

GPUO—Output 1 Connected 1 1

GPUO—Output 2 =~ Connected 2 4

GPU1—Output 1 3 (grayed) 2 (represents

GPU1—Output 2 4 (grayed) GPU1)

GPU2—Output 1 Connected (not | 5 (grayed) 3 (grayed)
enabled)

GPU2—Output 2 6 (grayed)
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Monitor Icons: nView Clone and Spanning Mode

Only outputs from the same GPU can be grouped together in nView Span mode or
nView clone mode.

When you enable nView Clone mode, Windows recognizes only the nView primary
display as connected, and the display corresponding to the nView secondary clone mode
display is shown to be not attached in the Display Properties Settings page.

When you enable nView Horizontal or Vertical Spanning mode, Windows
recognizes only the nView primary display as connected, and considers it to have a
resolution equal to the combined resolutions of both displays. The display corresponding
to the nView secondary spanning mode display is shown to be not attached in the Display
Properties Settings page.

Figure B.2 illustrates the Display Properties Settings page for a system with four displays
where displays 1 and 3 are in a Clone mode configuration and displays 4 and 2 are in a
Spanning mode configuration.

Display Propertics

| Themes | Detkion | Scieen Saver | Appestance| Seltings
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Figure B.2 nView Clone Mode and Spanning Mode
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Determining GPU Order

The following are guidelines to help determine the order in which GPUs are considered
when the operating system enumerates displays.

Default GPU Order

Table B.4 shows which GPU is designated as GPUO for the purpose of monitor ordering
in a multiple-GPU system.

Table B.4 Windows Monitor Numbering Example-Default Boot Priority

Configuration Which GPU is considered first

AGP + PCI GPU on the AGP bus (by default)

PCI-E + PCI GPU on the PCI-E bus (by default)

NVIDIA Quadro NVS 400 GPU driving the monitor connector closest to the

(or other multi-GPU graphics card edge connector.

cards)

NVIDIA Quadro NVS 440 GPU driving the monitor connector farthest way
from the card edge connector.

Monitor Order After Changing the GPU Boot Priority in the BIOS

By default, in a multi-graphics card system the AGP or PCI-E bus has boot priority in the
system BIOS, meaning that GPUO resides on the AGP or PCI-E graphics card and
displays are enumerated beginning with that GPU.

If you change the boot priority to the PCI bus, displays are enumerated in the same order
except that the first display is enumerated from the GPU on the PCI bus. After that, the GPUs

and displays are enumerated in the standard priority, as shown in Table B.5.

Table B.5 Windows Monitor Numbering Example-PCl Boot Priority

Connector Position Monitor Number Under | Monitor Number
Windows Vista/ Under Windows XP
Windows 7

GPUO (AGP/PCI-E)—OQutput 1
GPUO (AGP/PCI-E)—OQutput 2
GPU1 (AGP/PCI-E) —Output 1
GPU1 (AGP-PCI-E) —Output 2
GPU2 (PCIl) —Output 1
GPU2 (PCl) —Output 2

N =[O0 Ul N W
o = Ul W AN

(
(
(
(
(
(
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PROFESSIONAL 3D STEREO

This appendix discusses professional or quad-buffered 3D stereo. It contains the
following sections:

» “About Workstation 3D Stereo” on page 53
» “Using Workstation 3D Stereo” on page 55

About Workstation 3D Stereo

The NVIDIA graphics driver comes with built-in support for 3D stereoscopic viewing of

OpenGL applications developed for 3D stereo. This is also referred to as “professional”,

“workstation”, or “quad-buffered” stereol.

Basic Workstation 3D Stereo Requirements

To use workstation stereo, you need the following;:
» OpenGL application that is developed for stereo
The application must be designed to render different content to the left and right eye.
» NVIDIA Quadro graphics card, except NVIDIA Quadro NVS cards
» Proper driver configuration through the NVIDIA Control Panel

1. This is not to be confused with the NVIDIA consumer 3D stereo driver that lets you view 3D applications in
stereo even if they are not developed for stereo.
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Using 3D Stereo under Different System Configurations

Supported Stereo Configurations Under Windows XP

The NVIDIA drivers support both full-screen and windowed stereo under Windows XP.
Table C.1 details which stereo modes are supported under which GPU/display

configurations.

Table C.1  Workstation Stereo Configurations: Windows XP
System Configuration Active Stereo Display Modes Passive Stereo Display Modes
Single GPU - Supported Supported
Single display
Single GPU - Supported Supported (including
Multiple displays CloneMode)

See Using Workstation

3D Stereo with Multiple

Displays for more

information.

Multi-system - Supported Supported (including

Multiple displays

Requires a G-Sync or
G-Sync Il card with all
displays frame
synchronized.

CloneMode)

Multi-GPU Mode

The driver does not use the
second GPU and
automatically switches to
single-GPU mode.

The driver does not use
the second GPU and
automatically switches to
single-GPU mode.

SLI Mode The driver does not use the | The driver does not use
second GPU and the second GPU and
automatically switches to automatically switches to
single-GPU mode. single-GPU mode.

SLI Mosaic Supported Via NVAPI
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Supported Stereo Configurations Under Windows Vista/Windows 7

The NVIDIA drivers support both full-screen and windowed stereo under Windows
Vista or Windows 7. Table C.2 details which stereo modes are supported under which
GPU/display configurations.

Table C.2 Workstation Stereo Configurations: Windows Vista/Windows 7

System Configuration Active Stereo Display Passive Stereo Display
Modes Modes

Single GPU - Single Supported Supported

display

Single GPU - Multiple Not supported Supported (including

displays CloneMode)

Multi-system - Multiple Not supported Not supported

displays

Multi-GPU Mode Not supported Supported (including
CloneMode)

SLI mode Not supported Not supported

Using Workstation 3D Stereo

Basic 3D Stereo Setup

1 Set up the 3D stereo viewing hardware according to the instructions that came with
your hardware.

2 Start the system, then right-click the desktop and click NVIDIA Control Panel to
open the panel.

3 From the menu bar, click View then click Advanced.

4 From the Select a Tusk pane, click Manage 3D Settings, then click the Global
Settings tab.

5 Under the Settings: Feature column, click Stereo - Enable, then click the
corresponding Setting list arrow and select On.

6 Click Apply.
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Selecting the Stereo Display Mode

Typically, the driver detects the type of stereo hardware that is installed and
automatically selects the appropriate display mode. If you cannot view 3D stereo with
your application after these steps, then manually select the display mode as follows:

1 Re-open the Global Settings tab in the NVIDIA Control Panel Manage 3D Settings page

2 Under the Settings: Feature column, click Stereo - Display mode, then click the
corresponding Setting list arrow and select the stereo display mode that is appropriate
for your stereo viewing hardware.

e See Table C.3, “List of Supported Stereo Display Modes” on page 56 for a
description of the available modes.

o If you want to use passive stereo using nView Clone mode, be sure to set up Clone
mode using the Set Up Display Configuration page.

3 Click Apply.

uses page-flipped images.

Not supported on GeForce 8
series and later GPUs (including
NVIDIA Quadro FX 4600 and
NVIDIA Quadro FX 5600)

Table C.3 List of Supported Stereo Display Modes
Option Description Hardware
Examples
On-board DIN - Time sequential, page-flip stereo,
connector with stereo shutter glasses
connected directly to a 3-pin DIN
VESA connector.
On-board DIN Time sequential, page-flip stereo, | NVIDIA GeForce
connector with NVIDIA IR emitter connected to | 3D Vision
(with NVIDIA IR the 3-pin DIN VESA connector via
Emitter) dongle.
Generic active stereo = Any time sequential, page-flip Displays which
stereo accept time-
sequential
stereo signals
Generic active stereo = Any time sequential, page-flip NVIDIA GeForce
(with NVIDIA IR stereo using the NVIDIA IR emitter 3D Vision
Emitter)
Shutter Glasses (DDC Time sequential, page-flip stereo. 10 Display
stereo) Typically implemented using Eyewear
shutter glasses connected to a DTI LCD Display
dongle on the VGA output, but lcuiti LCD
accommodates other hardware that
Eyewear
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Table C.3

Option

Description

List of Supported Stereo Display Modes (continued)

Hardware
Examples

nView Clone Mode

Uses projectors from two displays in
nView Clone mode-left image on
one display, right image on the
other. Passive polarized filters
(glasses) isolate the left and right
images to the corresponding eyes of
the viewer.

Dep3D System

nView Clone Mode

(with NVIDIA IR Emitter

using external stereo
signal)

Clone mode passive to active stereo
conversion - the left/right images
are displayed through separate
monitor outputs and converted to
active stereo by the display.

The display feeds the stereo toggle
signal into the NVIDIA IR emitter
using a 3-pin DIN stereo cable.

projectiondesign
F10

Vertical interlaced
stereo monitor

Vertical pixel columns alternate
between left and right images. A
beam splitter directs the left and
right images to the corresponding
eyes of the viewer.

SeeReal
Technologies

Color interleaved

Custom implementation for the

Sharp3D Stereo

display Sharp 3D Display, an auto- Digital Flat
stereoscopic display that uses a Panels
parallax barrier technology to
provide 3D stereo on the LCD.
Horizontal interlaced | Horizontal scan lines alternate VRex, Inc.
stereo display between left and right images.
Passive polarized filters (glasses)
isolate the left and right images to
the corresponding eyes of the
viewer.
3D DLP display Projector or rear projection TV Samsung or
using Texas Instrument’s Digital Mitsubishi DLP
Light Processing (DLP) technology. HDTV with
Requires shutter glasses. shutter glasses
3D DLP display Projector or rear projection TV Samsung or
(with NVIDIA IR using Texas Instrument’s Digital Mitsubishi DLP
Emitter) Light Processing (DLP) technology. HDTV with
Requires NVIDIA GeForce 3D Vision | NVIDIA GeForce
IR emitter. 3D Vision
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Table C.3 List of Supported Stereo Display Modes (continued)

Option Description Hardware
Examples
3D DLP display INV Use if the “3D DLP display” option = Samsung or
mode results in reversed eyes. Mitsubishi DLP
HDTV with
shutter glasses
3D DLP display INV Use if the “3D DLP display (with Samsung or
mode NVIDIA IR Emiter) ” option results in | Mitsubishi DLP
(with NVIDIA IR reversed eyes. HDTV with
Emitter) NVIDIA GeForce
3D Vision
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Using Workstation 3D Stereo with Multiple Displays

In a multi-display system, you can move the OpenGL application window to all
monitors, although stereo might not be visible on all monitors.

Enabling 3D Stereo with Multiple Displays

To make sure that you successfully enable 3D stereo in a multi-display configuration and
avoid losing stereo settings, NVIDIA recommends first enabling stereo in single-display
mode and then closing the NVIDIA Control Panel before setting up multi-display modes.
1 Enable 3D stereo

a Open the NVIDIA Control Panel, then set single-display mode using the Set Up

Display Configuration page.
b Set stereo settings using the Manage 3D Settings page.
¢ Close the NVIDIA Control Panel.

2 Enable multiple displays

Using either the Windows Display Properties page or by re-opening the NVIDIA
Control panel->Set up Display Configuration page, set the desired multi-display
mode.

3 Set up other NVIDIA Control Panel->Workstation settings as needed, such as frame
locking.

3D Stereo Under nView Modes

Under nView multi-display modes, both displays must be set to the same resolution and
refresh rate. If the refresh rates are different, the 3D stereo will be displayed on the
display with the highest refresh rate.

3D Stereo Under Dualview Modes

Under Dualview mode, all displays must be set to the same refresh rate for 3D stereo to
be displayed on all the Dualview displays. If the refresh rates are different, 3D stereo will
be displayed on the display with the highest refresh rate.
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NVIDIA APPLICATION
CONFIGURATION ENGINE

This appendix discusses the NVIDIA application configuration engine (ACE) for
professional workstation applications. It contains the following sections:

» “Introduction” on page 61

» “Using ACE with Supported Applications” on page 61

» “Using Applications that are not Supported by ACE” on page 63
» “Adding to the List of ACE-detectable Applications” on page 66
» “Frequently Asked Questions” on page 67

NVIDIA CONFIDENTIAL
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Introduction

Background

Workstation application profiles are a group of software settings used by the NVIDIA
graphics driver to provide optimum performance when using a selected application. If
there is an available profile for an application, it should be used in order to ensure correct
application behavior and optimal performance.

About NVIDIA ACE

With the NVIDIA application configuration engine (ACE), the graphics driver can now
detect supported workstation applications and apply the appropriate profile settings
automatically—you no longer need to manually select the profile from the NVIDIA
Control Panel. If you run more than one application at a time, ACE makes sure that the
driver applies the appropriate profile settings to each application.

Using ACE with Supported Applications

When you run an application that is supported by ACE, you do not need to do anything
special. The driver will detect the application and apply the appropriate profile settings
automatically.

How to Determine ACE Support

To determine whether your application is supported by ACE:

1 Open the NVIDIA Control Panel and make sure that Advanced Settings is selected from
the control panel tool bar.
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2 From the Select a Tusk pane, under 3D Settings, click Manage 3D Settings, then click
the Program Settings tab. The Select a program to customize list box contains a list of the

ACE-detectable applications.

[ NVIDIA Control Panel

Adjust image settings with preview
flanage 3D settings

= Display
Run display optimization wizard
Move CRT screen position
Change resolution
Adjust deskbop color settings
Rotate display
Manage custom resolutions

= Video & Television
Adjust video color settings
Adjust video image setkings

=) Workst ation
Wiew system topology
Send graphics to SDT cutppit

Fle Edt View Help

@ Back ~ () Advanced Settings ~
Select & Task...

(=) 30 Settings

Manage 3D Settings - 1

You can change the global 3D settings and create overrides for specific programs. The
overrides will be used automatically each time the specified programs are launched.

Ngs.

| —

I would like to use the following 3D settings:

1. Select & program ko customize:

] Adobe After Effects b

(] adobe After Effects
] Adobe Premiere Pro €53
] Alkair HyperWorks

= ASYS appiications

] Autodesk 3ds Max

] Autodesk DWF viewer
] Autodesk AutaCAD

] Awtodesk DesignReview
] Autodesk Inventor

%Wi

ing

global/setting (Application-controlled)

llobAl setting (Application-controlled)
il setting (Auto-select)

 |global setting {Use hardware)

Enable overlay

Exported picel types
Extension limit

Force stereo shuttering
Maximize: texture memory
Maximum pre-rendered frames

Use global setting (Off)

Use global setting (Color indexed overlays...
Use global setting (OFf)

Use global setting (Off)

Use global setting (OFf)

Use global setting (3)

3

Description:

Select a program to apply different setting values than those found on the Global Settings tab. You can add or remove
programs from this list by clicking on the Add or Remave buttans,

Figure D.1 Manage 3D Settings Page-ACE-detectable applicati(;ns

Modifying Settings for ACE-detectable Applications

You can modify the settings as follows:

1 Select the application from the Select a program to customize box.

The settings for the application are listed in the Specify the settings for this program box.

2 Click the setting you want to change and then select the new setting from the drop-

down list.

3 Click Apply when you are finished making your changes.
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Using Applications that are not Supported by ACE

If your application is not detectable by ACE, then you should configure an application
profile and make sure it is set before running the application.

Setting Up an Application Profile Using Global Presets

1 From the Manage 3D Settings page, click the Global Settings tab.

2 Click the Global Presets list arrow.
£ NYIDIA Control Panel =13

Fle £t Vew Help

@ Back ~ \_j Advanced Settings

Select a Task... 3 )
3D Settings R Manage 3D Settmgs
Adjust image settings with preview =l
EECE R *fou can change the global 3D settings and create oveirides for specific progiams. The overrides will be used automatically each
= Display time the specifisd programs are launched.

Run display optimization wizard
Move CRT screen position
Change resolution

Adjust desktop color settings

Rotate display Global m Settings |
Manage custom resohitions
Global presets:

= Video & Television

1 would like to use the following 3D settings:

Adjust viden color ssttings Base profile v ‘ Restore
Adjust videa image settings
= Workstation 3D App - Default Global Settings
View system topology 3D App - Game Development 1
Send graphics to DI outpu gg :: - vﬁ;“g;ﬁ?m &)
Abaqus CAE | Viewsr
Autodask AlissSTUDIO
Autadesk Combustion
Autodesk Maya
AVEVA VANTAGE PDMS | Review

Brainstorm applications

Dassault Systemes CATIA - compatible
DENSO NADAMS bep)
ICEM Surf

15D HiICAD

MAXON CINEMA 4D
MICROCADAM Helix

Overwatch Systems RemoteView
PTC 3DPaint

PTC Pro/ENGINEER

RainStorm e mode
Redway3D

L| Siemens Medical syngo
Toyota TOGO

&

Descriptioms

This listbox contains all of the application-specific presets, Instead of individually setting all of the 3D features on your
graphics card, you can use the 3D settings in an application preset.

Figure D.2 Manage 3D Settings Page-Applications with Global Profiles,
Windows XP

3 Select one of the global presets:
e Under Windows Vista/Windows 7

Select a Base profile or one of the generic 3D App profiles, or create a new profile
(see “Adding to the List of ACE-detectable Applications” on page 66).

o Under Windows XP

Under Windows XP, the driver includes preset profiles for a number of applications
that are not ACE-detectable.

Select the application name from the drop-down list.
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If your application is not listed, then select Base profile or one of the generic 3D
App profiles, or create a new profile (see “Adding to the List of ACE-detectable
Applications” on page 66).

4 In the Settings box, you can modify the profile by clicking the setting you want to
change and then selecting the new setting from the drop-down list.

5 Click Apply when you are finished making your changes.

If you run a different application that is not ACE-detectable and do not want to use these
settings, then repeat these steps for the new application.

Be aware that these settings may affect any ACE profile settings that specify “Use global
setting”.

About the Global Presets

Global profiles, or presets, are a set of 3D settings that the driver applies to any
workstation application. While a specific profile contains settings that work best with a
particular application, the settings are applied to any workstation application you run, as
long as there are no ACE-detected program settings to override them.

The following are descriptions of the available global presets:

» Base profile

This preset lets you configure all the settings, and provides the most flexibility. Other
presets allow you to configure only a limited selection of settings.

» 3D App - Default Global Settings

This preset uses SLI single-GPU rendering mode, and is also useful when you need to
use non-SLI configurations.

» 3D App - Game Development

This preset is useful for game development when using an NVIDIA Quadro card. This
eliminates the need for game developers to switch to a GeForce graphics card as the
settings cause the Quadro card to run like a GeForce card.

» 3D App - Modeling AFR
This preset is useful for modeling applications, and uses SLI AFR mode.
» 3D App - Visual Simulation

This preset is useful for visual simulation applications, and uses SLI SFR mode.
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» Application-specific presets (for Windows XP): Table D.1 is an example of non
ACE-detectable applications for which there are preset global profiles. Consult the
NVIDIA Control Panel for the latest list of applications.

Table D.1 Application-specific Global Presets (Not supported by ACE)

Application

Abaqus CAE / Viewer

Autodesk AliasSTUDIO

Autodesk Combustion

Autodesk Maya

AVEVA VANTAGE PDMS / Review
Brainstorm applications

DENSO NADAMS

ICEM Surf

ISD HiCAD

MAXON CINEMA 4D
MICROCADAM Helix

Overwatch Systems RemoteView
PTC 3DPaint

PTC Pro/ENGINEER

RainStorm

Siemens Medical syngo

Toyota TOGO
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Adding to the List of ACE-detectable Applications

If your application is not listed in any of the profile lists in the Global Settings or Program
Settings tab, then you can create a profile for that application as follows:

Note: If your application is listed in the Global Settings tab (Windows XP only), then do not
create a new profile. Set the global preset for that application instead.

1 From the Manage 3D Settings page, click the Program Settings tab.
2 Click Add.

In the Open dialog box, navigate to the location of your application executable, then
click the executable file name and click Open.

4 The file name appears in the Select a program to customize list box.

5 In the Specify the settings for this program box, configure any settings by clicking the
setting you want to change and then selecting the new setting from the drop-down
list.

6 Click Apply when you are finished making your changes.

The new profile will be applied automatically whenever the application is run, just like
one of the default ACE profiles.

If your application was running while you created the new profile, you must restart the
application in order for the settings to be applied.
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Frequently Asked Questions

» What happens when I run more than one ACE-detectable application at the
same time?

The driver detects each application and applies the appropriate profile to each one
automatically.

» What happens when I run an ACE-detectable application and a non-ACE-
detectable application at the same time?

The driver applies the global preset to the non-ACE-detected application, and applies
the appropriate profile to the ACE-detected application. Note that any settings in the
ACE profile that specify “Use global setting” will be controlled by the global preset.

» Can I create my own application profile?

Only one profile can be created for a specific executable, so if your application is ACE-
detectable, do not create another profile for that application.

If your application is not ACE-detectable, and there is no global preset for it, then you
can create a new profile as described in “Adding to the List of ACE-detectable
Applications” on page 66.

» Can I create a new global profile for a specific application?

For applications that are not detected by ACE, you can select an existing global preset
and customize it, but you will not be able to save it under a custom name.

» Which global preset should I use?

Unless you know that a specific global preset is appropriate for your application (see
“About the Global Presets” on page 64), it is best to use the Base profile.
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Notice

ALL NVIDIA DESIGN SPECIFICATIONS, REFERENCE BOARDS, FILES, DRAWINGS, DIAGNOSTICS, LISTS, AND
OTHER DOCUMENTS (TOGETHER AND SEPARATELY, "MATERIALS") ARE BEING PROVIDED "AS IS." NVIDIA MAKES
NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE WITH RESPECT TO THE MATERIALS, AND
EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS
FOR A PARTICULAR PURPOSE.

Information furnished is believed to be accurate and reliable. However, NVIDIA Corporation assumes no
responsibility for the consequences of use of such information or for any infringement of patents or other
rights of third parties that may result from its use. No license is granted by implication of otherwise under
any patent rights of NVIDIA Corporation. Specifications mentioned in this publication are subject to change
without notice. This publication supersedes and replaces all other information previously supplied. NVIDIA
Corporation products are not authorized as critical components in life support devices or systems without
express written approval of NVIDIA Corporation.

HDMI

HDMI, the HDMI logo, and High-Definition Multimedia Interface are trademarks or registered trademarks of
HDMI Licensing LLC.

Macrovision Compliance Statement

NVIDIA Products that are Macrovision enabled can only be sold or distributed to buyers with a valid and
existing authorization from Macrovision to purchase and incorporate the device into buyer's products.

Macrovision copy protection technology is protected by U.S. patent numbers 5,583,936; 6,516,132;
6,836,549; and 7,050,698 and other intellectual property rights. The use of Macrovision's copy protection
technology in the device must be authorized by Macrovision and is intended for home and other limited
pay-per-view uses only, unless otherwise authorized in writing by Macrovision. Reverse engineering or
disassembly is prohibited.

OpenCL
OpenCL is a trademark of Apple Inc. used under license to the Khronos Group Inc.
Trademarks

NVIDIA and the NVIDIA logo are trademarks or registered trademarks of NVIDIA Corporation in the United
States and other countries. Other company and product names may be trademarks of the respective
companies with which they are associated.

Copyright
© 2009, 2010 NVIDIA Corporation. All rights reserved.
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